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IBM WebSphere Developer for zSeries Version 6.0.1
Installation Guide

This document contains information on the following tasks:
* Preparing for installation

« Installing WebSphere® Developer

* Installing required and optional workstation software

* Installing z/OS® server tools

* Recognizing known problems and limitations with installation

Where to find more information about WebSphere Developer

This file does not contain information about using WebSphere Developer. Refer to
the online help for that information.

For information about product problems and limitations, refer to the readme.htm]
file located in the root of the CD WebSphere Developer for zSeries® Install CD 1.

Introduction to WebSphere Developer

WebSphere Developer has a host component and a workstation client component.
The host component is typically installed by a site’s system programmer and is
transparent to the application programmers. For the remainder of this guide,
unless the host component is specifically called out, the term WebSphere Developer
will refer to the workstation component of the tool - the graphical user interface
powered by the Eclipse platform.

WebSphere Developer is a set of development tools built on the Rational® Software
Development Platform (RSDP) which itself is built on the Eclipse platform
(www.eclipse.org). Think of the Eclipse platform as the framework and
infrastructure provider and RSDP and WebSphere Developer as the tool
contributors.

Preparing for installation

To prepare for installation, you need to complete the following activities:
* Meeting media requirements
* Meeting hardware and software requirements

Meeting media requirements

You must have access to either of the following media to install WebSphere
Developer on the workstation:

¢ WebSphere Developer installation CDs:
— WebSphere Developer for zSeries Install CD 1
— WebSphere Developer for zSeries Install CD 2
— WebSphere Developer for zSeries Install CD 3
— WebSphere Developer for zSeries Install CD 4& EGL COBOL Generation Feature
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— WebSphere Developer optionally installable components ( CICS® TS for WebSphere
Developer and documentation) CD 5

— IBM® WebSphere Developer Options for z/OS CD 6
* WebSphere Developer for zSeries electronic images

Once you have downloaded the WebSphere Developer images from Passport
Advantage® and expanded them, the following directories apply to installing
WebSphere Developer on the workstation:

— DISK1
- DISK2
— DISK3
— DISK4
— DISK5
— DISK6

You must also have access to either of the following media to install required z/OS
server tools on the z/OS host:

* WebSphere Developer installation CD:
— IBM WebSphere Developer Options for z/OS
* WebSphere Developer electronic image

Once you have downloaded the WebSphere Developer images from Passport
Advantage and expanded them, the following directory applies to installing
required software on the z/OS host:

- DISK6
See the WebSphere Developer Host Planning Guide for details on installing required
z/0OS server tools.

In the remainder of this document, you can match references to CDs with

references to electronic image directories as shown in the following table:

Table 1.

CD Name Electronic Image Directory Name

WebSphere Developer for multiplatforms Install CD 1 DISK1

WebSphere Developer for multiplatforms Install CD 2 DISK2

WebSphere Developer for multiplatforms Install CD 3 DISK3

WebSphere Developer for multiplatforms Install CD 4 & | DISK4
EGL COBOL Generation Feature

WebSphere Developer optionally installable components (| DISK5
CICS TS for WebSphere Developer and documentation)

IBM WebSphere Developer Options for z/OS DISK6

When instructed to insert a given CD and run launchpad.exe in the root of the
CD-ROM drive, simply open the corresponding electronic image directory and run
launchpad.exe.

Meeting hardware and software requirements

The following information on hardware and software requirements for WebSphere
Developer, is also available in Prerequisites for WebSphere Developer. A copy of this
document is available in the root directory of WebSphere Developer for zSeries Install
CD 1.
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Note: User authorization can affect your ability to perform the installation. You
must have administrator authority to install this product on your
workstation.

Prerequisites for WebSphere Developer for zSeries
IBM WebSphere Developer is a licensed program to support users who wish to
write large-scale business applications.

There are prerequisites and corequisites for using this software.
WebSphere Developer prerequisites: Hardware Requirements

WebSphere Developer requires the following hardware:

Table 2. Hardware Requirements for WebSphere Developer

Processor Intel™ Pentium® 11T 800 MHz or higher is
required
Memory 768MB RAM is required, but 1GB RAM or

higher is recommended

Disk Space 2.5 GB minimum disk space is required to
install WebSphere Developer. This assumes
you are installing on a system with RAD or
RSA V6.0, and includes space required to
install maintenance updates for those
products. This does not include space
required for language packs and is in
addition to space required for the resources
you develop. The maximum amount of
space required depends on the optional
features selected for installation, and on the
level of product maintenance you have
installed. Installation also requires an
additional 2.5 GB of temporary space for
product update installation files and other
files.

Monitor and Video Card A VGA display of 1024x768 or higher is
required

Supported Operating Systems

WebSphere Developer requires any of the following operating systems:

Table 3. Operating Systems for WebSphere Developer

Windows® XP Professional with Service Pack 1 or higher

Windows 2000 Professional or Server or Advanced Server
with Service Pack 3 or higher

Windows Server 2003 Standard or Enterprise Edition

Additional Software Requirements

IBM WebSphere Developer for zSeries Version 6.0.1 Installation Guide
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4

WebSphere Developer requires the following software:

Table 4. Software Requirements for WebSphere Developer

Rational Application Developer or Rational V6.0
Software Architect

TCP/IP Installed and configured

Microsoft® Internet Explorer Ve6.0

Software requirements for features

WebSphere Developer requires additional software if you wish to use any of the
product features specified in the following table:

Table 5. Additional Software Requirements for WebSphere Developer

DB2® UDB V8.2, as is shipped for optional To use the COBOL and PL/I Stored
installation with WebSphere Developer. Procedures and to check the syntax of
embedded SQL statements.

CICS Transaction Gateway v6 and CICS TS To provide a local CICS development
for WebSphere Developer, as is shipped for environment.
installation with WebSphere Developer.

IBM WebSphere Host Access To access host applications.
Transformation Services V6, as is shipped
for installation with WebSphere Developer.

IBM WebSphere MQ Series for To utilize MQ Series function in conjunction
multiplatforms Version 5.3 and IBM with WebSphere Developer and EGL.
WebSphere MQ Series for z/OS Version 5.x

Preparing your workstation for installing WebSphere Developer

To prepare your workstation for installing WebSphere Developer, do the following:

1. Verify that you meet the minimum hard disk space requirements to install the
product. 2 GB disk space (based on NTFS) is required in addition to space
for the resources you develop. The following table provides an account of
space requirements according to each aspect of the installation process.

Product code description Hard disk space required Comments

Downloaded zip files 24 GB These files can be deleted
after you extract the file
contents.

Extracted files to perform 2.7 GB These files represent the

installation content of shipped product

installation CDs. These files
can be deleted after the
product installation is
complete.
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Product code description

Hard disk space required Comments

Installed files that are
required

25GB This is the minimum disk
space is required. The

maximum amount of space
required depends on the
optional features selected for
installation. This does not
include space required for
language packs and is in
addition to space required
for the resources you
develop. This requirement
applies whether you install
by way of CD or
downloaded zip files.

. Ensure that your environment variable TEMP points to a valid temporary
directory with at least 2.5 GB of free disk space.

Note: Approximately 2.1 GB of this required disk space is for required
maintenance update installation files and can be redirected to a directory
other than that pointed to by your TEMP environment variable by
specifying a different location when you are prompted during the
WebSphere Developer installation. The prompt for this temporary
location is separate from the prompt for the product installation
directory.

. Shut down IBM HTTP server and WebSphere Application Server. They must
not be running during installation.

. Close the Services window (Start > Settings > Control Panel > Administrative
Tools > Services).

. If you have a version of WebSphere Studio Enterprise Developer, you should
make a backup copy of your workspace.

Note: A workspace created in WebSphere Developer or accessed and saved by
WebSphere Developer cannot be used with any previous version of
WebSphere Studio Enterprise Developer.

. WebSphere Developer 6.0.1 will not coexist with versions of WebSphere Studio

Enterprise Developer prior to 5.1.1 that have the z/OS IDE feature installed.

These previous installs must be manually removed prior to installing

WebSphere Developer.

. WebSphere Developer will not coexist with previous installs of VA COBOL or

VA PLI. The WebSphere Developer installation program will detect these

conflicts and attempt to uninstall them if you choose to allow that action.

Otherwise, these products must be uninstalled manually.

. If you have a version of WebSphere Studio Enterprise Developer prior to 5.1.1,

you must uninstall the older version manually. To uninstall a version of

WebSphere Studio Enterprise Developer prior to 5.1.1 :

a. From the Windows Control Panel, click Add/Remove Programs and follow
the instructions in the wizard to remove any of the following WebSphere
Studio Enterprise Developer features that are displayed:

+ IBM WebSphere Studio Enterprise Developer Base Feature
* IBM WebSphere Studio Enterprise Developer Compile Feature
* IBM WebSphere Studio Enterprise Developer Edit Feature

* IBM WebSphere Studio Enterprise Developer Licensing Feature
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* IBM WebSphere Studio Enterprise Developer Validation Feature

You can optionally wait to reboot your machine until you have removed all
of the WebSphere Studio Enterprise Developer features.

b. Delete the WebSphere Studio Enterprise Developer installation directory.

Installing WebSphere Developer

6

Once you have completed preparations for installing WebSphere Developer,
proceed according to the following instructions:

“Attended install”|

“Silent install” on page 7]

Note: Workspaces used with WebSphere Developer 6.0.1 are not compatible with

WebSphere Developer 6.0. If you plan to uninstall the WebSphere Developer
6.0.1 update and continue to use WebSphere Developer 6.0, you should back
up your WebSphere Developer 6.0 workspaces before installing WebSphere
Developer 6.0.1.

Attended install

1.

Insert the CD WebSphere Developer for multiplatforms Install CD 1 into your
computer CD-ROM drive.

If Autorun does not automatically start the installation process, run
Taunchpad.exe, which is located in the root directory of the CD.

You can optionally launch the Readme file and release notes for late breaking
information; which may include information on product installation.

When you are ready to proceed with the installation, click Install IBM
WebSphere Developer for zSeries Version 6.0.1.

On the InstallShield wizard welcome page, click Next.

Review the license agreement. To accept the agreement, click the radio button
labeled, "I accept the terms in the license agreement”. Click Next.

Note: You cannot proceed with the installation if you do not accept the terms
in the license agreement.

Specify the directory where you would like to install WebSphere Developer
for zSeries Version 6.0.1

Note: WebSphere Developer does not have to be installed to the same location
as RAD/RSA 6.0. The RAD/RSA 6.0 install location is the default
location, but WebSphere Developer Version 6.0.1 can be installed
elsewhere.

Specify the directory path where you would like to install WebSphere
temporary files for the RAD/RSA 6.0.0.1, J2C, and WebSphere Developer 6.0.1
updates. Either type the path in the Directory Name field or use the browse
button to locate the directory. Then click Next.

Select any optional features you would like to install. Then click Next. Here is
a description of the options and why you may want to install them:

Option title Description Reason for installing

Software Configuration A WebSphere Developer to * You plan to use SCLM for
Library Manager (SCLM) an SCM that runs on the

software configuration

z/0S platform management.
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Option title Description Reason for installing

Language Pack The language pack contains |+ yoyu plan to use

the user interface and
documentation for supported supported language other
national languages other than | 0 English.

English. Supported languages
are: Brazilian Portuguese,
French, German, Italian,
Japanese, Korean, Simplified
Chinese, Spanish, and
Traditional Chinese.

Note: By default, this feature
is not selected if your system
locale is English. It is selected
by default if your system
locale is one of the other
supported national
languages.

WebSphere Developer in a

10.

11.

Review the list of features that are planned for installation. If you would like
to change your options, click Back. To proceed with the installation of the
listed features, click Next.

When the wizard indicates that product installation has completed, click
Finish.

Silent install

You can do a silent install of WebSphere Developer.

Creating a network installation image
You can place a copy of the installation image on a network drive.

In order to run the installation program from a network drive, you must either
work with a downloaded electronic image of WebSphere Developer or copy the
contents of the CDs as described below.

You need approximately 2.7 GB of disk space to copy the files from the CD to the
hard drive, or 5.1 GB if you are using downloaded electronic images (2.4 GB for
the downloaded files and 2.7 GB for the extracted files). To copy the files from the
CDs:

1.
2.
3.

Insert the first WebSphere Developer installation CD into your CD drive.
Create a temporary directory (for example, d:\temp).

Under the temporary directory, create a subdirectory called disk1. This
subdirectory must be called disk1 and it must be in lower case.

Copy all the files and directories on the first installation CD to the disk1
subdirectory in the temporary directory.

Insert the second WebSphere Developer installation CD into your CD drive.

Under the temporary directory, create a subdirectory called disk2. This
subdirectory must be called disk2 and it must be in lower case.

Copy all the files and directories on the second installation CD to the disk2
subdirectory in the temporary directory.

Insert the third WebSphere Developer installation CD into your CD drive.

Under the temporary directory, create a subdirectory called disk3. This
subdirectory must be called disk3 and it must be in lower case.

IBM WebSphere Developer for zSeries Version 6.0.1 Installation Guide
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10. Copy all the files and directories on the third installation CD to the disk3
subdirectory in the temporary directory.

11. Insert the fourth WebSphere Developer installation CD into your CD drive.

12. Under the temporary directory, create a subdirectory called disk4. This
subdirectory must be called disk4 and it must be in lower case.

13. Copy all the files and directories on the fourth installation CD to the disk4
subdirectory in the temporary directory.

14. (Optional) Under the temporary directory, create a subdirectory called disk5.
This subdirectory must be called disk5 and it must be in lower case.

15. (Optional) Copy all the files and directories on the fifth installation CD to the
disk5 subdirectory in the temporary directory.

16. (Optional) Under the temporary directory, create a subdirectory called disk®6.
This subdirectory must be called disk6 and it must be in lower case.

17. (Optional) Copy all the files and directories on the sixth installation CD to the
disk6 subdirectory in the temporary directory.

Note: If you map to a network drive without specifying a device name (for
example, \\computername\sharename), you may get the following message
when you try to install WebSphere Developer: The wizard cannot continue
because of the following error: could not load wizard specified in
/wizard.inf(104). The work around is to locally map to the network drive by
specifying a device name (for example, x:\sharename).

Invoking a silent installation
The WebSphere Developer installation program can be run silently if you do not
want to interact with the installation wizard.

Setting up your local images: Prior to silently installing WebSphere Developer,
you must set up your local images:

1. You need approximately 5.1 GB of disk space to download and unpack the
images. If you do not have enough disk space to install the product, a log will
be generated in the \logs directory indicating that the install failed due to not
enough disk space.

2. Ensure that the user ID that you are using does not contain double-byte
characters.

3. Create a local or network installation image as described in
[network installation image” on page 7 |if you have not done so already. If you
only want to install WebSphere Developer, you only need to copy the
information from the first four CDs.

Silently installing the default features to the default directory: The following
features are installed by default when silently installing WebSphere Developer:

* WebSphere Developer for zSeries Version 6.0.1
* Language Pack (if your system locale is non-English)

To install WebSphere Developer silently with only the default selected features to
the default directory system_drive: \Program Files\IBM\wdz:

1. Copy your images as described in[“Setting up your local images,”|if you have
not done so already.

2. From the command line, change to the \disk1\setup directory in the temporary
directory (for example, d:\temp\disk1\setup) that you created in a previous
section.
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3. Run the following command:
setup -silent

4. Silently installing WebSphere Developer may take a while to complete. To
determine when the installation completes, you may monitor the
WS_installdir\logs directory periodically. If the license_wdz.log file appears,
then the silent installation has completed.

Silently installing to a different directory: By changing the installLocation
parameter, you can install WebSphere Developer to a different directory. For
example, if you want "d:\my wsentdev” to be your installation directory, follow
these steps:

1. Copy your images as described in[“Setting up your local images” on page 8)if
you have not done so already.

2. From the command line, change to the \disk1\setup directory in the temporary
directory (for example, d:\temp\disk1\setup) that you created in a previous
section.

3. Run the following command:
setup -silent -P installlLocation="d:\my wsentdev"
(In this example, only the default features are installed.)

4. Silently installing WebSphere Developer may take a while to complete. To
determine when the installation completes, you may monitor the
WS_installdir\logs directory periodically. If the license_wdz.log file appears,
then the silent installation has completed.

Silently installing additional WebSphere Developer installation features:
WebSphere Developer provides you with a sample response file that silently installs
all the default features. This response file is called responsefile.txt and it is located in
the \disk1\util directory. If you want to change the response file to install other
features, it is recommended that you first make a backup copy of responsefile.txt.

You may also update the response file to install one or more optional WebSphere
Developer installation options. The following table shows the response file options
and their corresponding entries in the response file.

Table 6. List of response file options

Response file option

Response file entry

Temporary product update installation files directory |updaterDestination.directory

Product installation directory installLocation

Language Pack

feature_lang_pack_wdz_win32

Software Configuration Library Manager (SCLM) feature_sclm_win32.active

To silently install any of the response file options:
1. Copy responsefile.txt to a new file, for example myresponsefile.txt.
2. Edit your copy of the response file.

3. Locate the line containing the installation feature name shown in the above
table.

Note: The updaterDestination.directory option is controlled with a "-W" at the

beginning of the line in the response file, rather than a "-P" like the rest
of the options.
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For example, if you want to install the SCLM feature, you would locate the
following line in the response file:

# -P feature_scIm win32.active=<value>
4. Make the following changes to this line:
a. Remove the # in the first column.
b. Change <value> to true.
In this example, this line would be changed to:
-P feature_sclm win32.active=true

5. Save your changes.

6. Copy your images as described in|“Setting up your local images” on page 8 if
you have not done so already.

7. From the command line, change to the \diskl\setup directory in the temporary
directory (for example, d:\temp\disk1\setup) that you created in a previous
section.

8. When you run the response file, add the -options parameter and the fully
qualified name of your response file as shown below:
setup -silent -options "Your_directory\myresponsefile.txt"
where Your_directory is the fully qualified directory name of where your
response file resides.

9. Silently installing WebSphere Developer may take a while to complete. To
determine when the installation completes, you may monitor the

WS_installdir\logs directory periodically. If the license_wdz.log file appears,
then the silent installation has completed.

Migrating WebSphere Developer for zSeries 6.0 workspaces to
WebSphere Developer for zSeries 6.0.1

If you have a workspace you used in WebSphere Developer for zSeries 6.0, and
you want to migrate the workspace for use with WebSphere Developer for zSeries
6.0.1, you must follow these steps.

1. Install WebSphere Developer for zSeries 6.0.1.
2. Start WebSphere Developer for zSeries, specifying the name of the workspace
you are migrating from WebSphere Developer for zSeries 6.0. The old

workspace is migrated so that all the old artifacts are present and appear in the
new workspace.

Migrating WebSphere Studio Enterprise Developer 5.1.1 and
5.1.2 workspaces to WebSphere Developer for zSeries 6.0.1

If you have a workspace you used in WebSphere Studio Enterprise Developer 5.1.1
or 5.1.2, and you want to migrate the workspace for use with WebSphere
Developer for zSeries 6.0.1, you must follow these steps.

Note: Be sure you still have WebSphere Studio Enterprise Developer 5.1.1 or 5.1.2

installed on your workstation.

1. Get a copy of plugin com.ibm.ftt.ui.migration (in CD 1, directory
\WSED51xMigration), and add it to your existing WebSphere Studio Enterprise
Developer 5.1.1 or 5.1.2 system. Add the plugin by copying the
com.ibm.ftt.ui.migration directory to the
install_directory\wstools\eclipse\plugins directory on your machine.

2. Start WebSphere Studio Enterprise Developer 5.1.1 or 5.1.2.
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Select Window -> Reset Perspective. You should see an action bar menu
Migration in the action bar.

Select Migration -> Prepare for Migration. A message appears and warns you
that this action will make your workspace unusable on WebSphere Studio
Enterprise Developer 5.1.1 or 5.1.2. You are asked if you want to continue.

Confirm that you want to continue. A message is displayed informing you that
a copy of the workspace has been saved and that the old workspace should
now be used on a WebSphere Developer for zSeries system where the
migration will be completed.

Uninstall WebSphere Studio Enterprise Developer 5.1.1 or 5.1.2 and install
WebSphere Developer for zSeries 6.0.

Update WebSphere Developer for zSeries 6.0 to version 6.0.1.

Start WebSphere Developer for zSeries 6.0.1, specifying the name of the
workspace you are migrating from WebSphere Studio Enterprise Developer

5.1.1 or 5.1.2. The old workspace is migrated so that all the old artifacts are
present and appear in the new workspace.

Uninstalling WebSphere Developer

You must uninstall WebSphere Developer 6.0.1 BEFORE uninstalling the RAD/RSA
6.0 prerequisite product. Uninstalling RAD/RSA 6.0 before WebSphere Developer
6.0.1 will cause problems with the WebSphere Developer 6.0.1 uninstall.

If you want to uninstall WebSphere Developer for zSeries, complete the following
instructions:

1.

Start the Rational Product Updater from the Start menu. Select Programs ->
IBM Rational -> IBM Rational Product Updater. Select the Rollbacks tab,

select WebSphere Developer 6.0.1, and select the Roll Back Updates button to
uninstall the WebSphere Developer 6.0.1 update.

Note: Workspaces used with WebSphere Developer 6.0.1 are not compatible
with WebSphere Developer 6.0. If you plan to uninstall the WebSphere
Developer 6.0.1 update and continue to use WebSphere Developer 6.0,
you should back up your WebSphere Developer 6.0 workspaces before
installing WebSphere Developer 6.0.1.

From the Windows Control Panel, click Add/Remove Programs and follow the
instructions in the wizard to remove the following WebSphere Developer
feature:

* IBM WebSphere Developer for zSeries Version 6.0.1

Delete the WebSphere Developer installation directory. If WebSphere Developer
is installed to the default location, where RAD/RSA is also installed, delete
only the wdz and wdz_prod folders at this location. If a non-default location was
specified during install, delete the entire WebSphere Developer installation
directory.

Installing required z/OS server tools

See the WebSphere Developer Host Planning Guide for details on installing required
z/0OS server tools.
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Installing IBM CICS Transaction Server for WebSphere Developer

CICS Transaction Server for Windows provides a local CICS development platform
so you can develop CICS programs.

You can install CICS Transaction Server from the WebSphere Developer Web
Service Runtime and Scenario Selection dialog.

CICS Transaction Server has its own set of installation documentation, which is
available on the disk with the product.

Installing the Enterprise Generation Language COBOL extension

The Enterprise Generation Language COBOL extension is a separate feature that is
available on the IBM WebSphere Developer for zSeries CD 4. The extension allows
you to generate COBOL programs written in the Enterprise Generation Language.

You must have WebSphere Developer installed before installing this extension. To
install this extension, insert the Install CD 1 in your workstation and run
launchpad.exe, which is found on the root directory of the install CD. The
extension is installed in the same directory where you installed WebSphere
Developer.

Known problems and limitations

12

This section covers known problems and limitations with installation and
uninstallation.

For information about product problems and limitations, refer to the readme.htm]
file located in the root of the CD WebSphere Developer for multiplatforms Install CD 1.

To run manual updates, do the following:

1. Start the Rational Product Updater from the Start menu (Programs -> IBM
Rational -> IBM Rational Product Updater) and select the "Find Updates”
button on the Installed Products tab.

2. From the list of available updates, select the required updates and select the
Install Updates button

Product update installation limitation

* WebSphere Developer 6.0.1 automatically updates your RAD/RSA and ]J2EE
Connector Tools installations to maintenance level 6.0.1. If you have other
Rational brand products installed on your system besides the RAD/RSA
prerequisite product, the WebSphere Developer 6.0.1 installation may require
you to manually update these products before WebSphere Developer 6.0.1 can be
installed.

Limitation on PATH and CLASSPATH length

* Windows has a 1024 byte limit on the length of the system PATH and
CLASSPATH environment variables. The WebSphere Developer installation
process adds several directories to these variables and checks their lengths
before the installation to ensure that what is added by the install will not cause
the path lengths to exceed this limit. It is recommended that before installing
WebSphere Developer 6.0.1, customers shorten their PATH and CLASSPATH
variables if they are long. Here are some suggestions for doing so:
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— Remove any directories for products that are no longer needed or installed.

— Use the Windows 8.3 short name format for long directory names, e.g.
"C:\Personal Communications” might become "C:\Person~1".

Product uninstall procedure limitation

* WebSphere Developer 6.0.1 must be uninstalled before the RAD/RSA
prerequisite product is uninstalled or you may experience problems uninstalling
WebSphere Developer 6.0.1. If you uninstall RAD/RSA before uninstalling
WebSphere Developer 6.0.1, reinstall RAD/RSA to the exact same location where
it was originally installed, uninstall WebSphere Developer 6.0.1, and then
uninstall RAD/RSA again.

RAD/RSA 6.0.1 update

* There is a known problem with the RAD/RSA 6.0.1 update caused by the
update of Rational Agent Controller (RAC) during the update installation that
runs when WebSphere Developer 6.0.1 is installed. An error is written in the
"WS_InstallDir\logs\updater_rad601_err.log” file with the text,

Unable to complete action for feature "6.0.1” due to errors.
Unable to complete action for feature "com.ibm.rational.cdi.rac.601.win32" due to errors.
Command failed:
C:\Program Files\IBM\wdz\updater\workspace\proxies\eclipse\features
\com.ibm.rational.cdi.rac.601.win32_1.0.0 \temp\win_ia32\setup.exe -siler
CreateProcess:
C:\Program Files\IBM\wdz\updater\workspace\proxies\eclipse\features\com.ibm
\temp\win_ia32\setup.exe -silent -P hyadesdc_product.patch=True error-

This problem usually occurs when a directory or a file with no extension (e.g.
.txt, .doc, etc.) exists with the name "Program.” If such a file or directory exists,
delete or rename the file and run the WebSphere Developer 6.0.1 installation
again.

WebSphere Developer 6.0 and WebSphere Developer 6.0.1
workspace incompatibility

* Workspaces used with WebSphere Developer 6.0.1 are not compatible with
WebSphere Developer 6.0. If you start WebSphere Developer 6.0.1 using a
workspace from WebSphere Developer 6.0, your workspace will be migrated to
work with WebSphere Developer 6.0.1. If you plan to uninstall the WebSphere
Developer 6.0.1 update and continue to use any WebSphere Developer 6.0
workspace, you should back up your WebSphere Developer 6.0 workspaces
before installing WebSphere Developer 6.0.1.

Disk limitations

e Do not install to an HPFS network or local drive.Windows 2000 and Windows
NT® 4.0 have trouble handling long file names on HPFS.

¢ Do not install to a Novell NetWare drive. Installation will fail on a Novell
NetWare drive.

User authorization

When you install the product, you may receive a warning message if you are not
an Administrator. The message indicates that some programs may not work
correctly if they are not installed by an Administrator. You should log on as an
Administrator before beginning the WebSphere Developer installation.
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Shell extension (Windows NT)

If you get a message that indicates that the installation program has detected a
shell extension for Windows NT, the installation cannot proceed. You should then
perform the following steps:

1.

© o N O

Make sure you have an Emergency Recovery Disk. Instructions for creating this
are available in the Windows help documentation.

Type regedit.exe at a command prompt.

In the Registry Editor, expand the key
\\HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows
NT\CurrentVersion\Winlogon

Select the shell name in the name/data pairs for the above key. Important:
Make a note of the data recorded for this name, because you will need it after
installing WebSphere Developer.

Select Edit > Modify from the menu bar for the shell name/data pair.
Set the value for the shell name to Explorer.exe. Click OK.

Select Registry > Exit from the menu bar.

Restart and complete the WebSphere Developer installation.

Once installation is complete, restore the previous registry entry as follows:

a. Type regedit.exe at a command prompt.

b. In the Registry Editor, expand the key
\\HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows
NT\CurrentVersion\Winlogon

c. Select the shell name in the name/data pairs for the above key.

d. Select Edit > Modify from the menu bar for the shell name/data pair.

e. Restore the value for the shell name to the value that was recorded in Step 4.
Click OK.

f. Select Registry > Exit from the menu bar.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS”
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation

P.O. Box 12195, Dept. TL3B/B503/B313
3039 Cornwallis Rd.

Research Triangle Park, NC 27709-2195
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrates programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM for the purposes of developing, using, marketing, or distributing application
programs conforming to IBM’s application programming interfaces.
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Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. _enter the year or years_. All rights
reserved.

Programming interface information

Programming interface information is intended to help you create application
software using this program.

General-use programming interfaces allow you to write application software that
obtain the services of this program’s tools.

However, this information may also contain diagnosis, modification, and tuning
information. Diagnosis, modification and tuning information is provided to help
you debug your application software.

Warning: Do not use this diagnosis, modification, and tuning information as a
programming interface because it is subject to change.

Trademarks and service marks

The following terms are trademarks or registered trademarks of International
Business Machines Corporation in the United States, or other countries, or both:

« AFS®

. AIX®

» CICS

* DB2

+ DB2 Extenders""

+ DB2 Universal Database"
* IBM

« IMS™

+ MVS™

« 0S/390%

+ 0S/400°

¢ Passport Advantage
+ S/390°

* VisualAge®

* WebSphere

+ WorkPad®

* z/0S

» zSeries

Java'" and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States and other countries.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks or

registered trademarks of Microsoft Corporation in the United States, or other
countries, or both.
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UNIX® is a registered trademark of The Open Group
Linux" is a registered trademark of Linus Torvalds.

Rational are trademarks of International Business Machines Corporation and
Rational Software Corporation®, in the United States, other countries, or both.

Intel and Pentium are trademarks of Intel Corporation in the United States, or
other countries, or both.

Other company, product, and service names, which may be denoted by a double
asterisk(**), may be trademarks or service marks of others.
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Readers’ Comments — We’d Like to Hear from You

IBM® WebSphere® Developer for zSeries Version 6.0.1
IBM WebSphere Developer for zSeries Installation Guide
Version 6.0.1

Publication No. SC31-6316-05

Overall, how satisfied are you with the information in this book?

Very Satisfied Satisfied Neutral Dissatisfied Very
Dissatisfied
Overall satisfaction ] ] ] O O

How satisfied are you that the information in this book is:

Very Satisfied Satisfied Neutral Dissatisfied Very
Dissatisfied
Accurate ] O O ] ]
Complete O O ] ] ]
Easy to find ] ] ] O ]
Easy to understand O O 0 U u
Well organized O O O] U U
Applicable to your tasks O ] | O ]

Please tell us how we can improve this book:

Thank you for your responses. May we contact you? [] Yes [] No

When you send comments to IBM, you grant IBM a nonexclusive right to use or distribute your comments in any
way it believes appropriate without incurring any obligation to you.

Name Address

Company or Organization

Phone No.
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